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NOTICE OF UNCERTIFIED FUNCTIONALITY

This document is designated for use with the Unity 3.2.1.0 voting system, which 
has been tested to the standards of the 2002 Voting System Standards (VSS) to 
include a limited system configuration and feature set. Please be advised that this 
system and associated documentation includes functionality and descriptions of 
functionality that have not been fully tested or certified to the VSS standards. 

The products and/or system features designated below HAVE NOT COMPLETED 
TESTING FOR CERTIFICATION BY THE ELECTION ASSISTANCE 
COMMISSION (EAC) to the requirements of the VSS:

UNCERTIFIED PRODUCTS

System Hardware

• Automated Bar Code Reader

• iVotronic DRE Precinct Tabulator

System Software

• Unity Data Acquisition Manager

• Unity iVotronic Ballot Image Manager

UNCERTIFIED SYSTEM FEATURES

Network Results Transmission

• Including remote transmission of vote data and local networking of central 
tabulators. Local networking of Election Management System workstations 
and reporting workstations is supported. 

If your jurisdiction requires voting system certification at the Federal level or you 
have questions about your jurisdiction’s certification requirements, please refrain 
from using the products and system features listed above until you have received 
approval from your State Election Authority. USE OF ANY UNCERTIFIED 
SYSTEM FEATURES NOTED ABOVE WILL NEGATE THE UNITY 3.2.1.0 EAC 
FEDERAL CERTIFICATION. ES&S shall not be held responsible for any 
unauthorized use of the foregoing products and system features.

Please visit www.eac.gov for more information regarding United States Federal 
voting system certification requirements and procedures. Contact the Elections 
Authority for your jurisdiction with any questions about your local laws and 
requirements.

http://www.eac.gov
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Chapter 1: Introduction

Election Data Manager and Image Manager use Audit Manager to store detailed 
logs of the actions performed in both programs. Open Audit Manager to access 
audit logs and control user access for Election Data Manager and Image 
Manager.

Operations Support Frequently Asked Questions

How is the system purchased?

Purchase Audit Manager by contacting your ES&S representative. 

How is the system installed?

Install Audit Manager by following the steps in the ES&S implementation plan. 
Installation instructions are also included in the System Operations 
Procedures manuals.

How is the system set up?

Follow the steps in the ES&S implementation plan to set up the system. Setup 
instructions are also included in the System Operations Procedures manuals.

How do you verify the system?

You may verify the system in a variety of ways. 

• Compare the serial numbers on the hardware to the numbers on the 
purchase order.

Contact your ES&S representative by calling 877-377-8683 (USA & Canada) or 
402-593-0101 (International).

Refer to Install Audit Manager in this manual for instructions for installing Audit 
Manager.
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 Chapter 1: Introduction 2
• Compare the software version in the About window to the version listed on 
the purchase order.

• The Acceptance Checklist will aid in the verification of the system.

What training is required?

Training is determined at the time the system was purchased. 

What checklist should be followed?

Use the Acceptance Checklist to ensure that the system has been delivered 
and is performing as expected.

Contact ES&S for Technical Support

This manual should aid you in accomplishing most Audit Manager-related tasks. 
However, if you need additional assistance, or if you encounter a processing 
problem or system error, ES&S’s technical support staff can provide advice and 
help you resolve the situation.

When you contact ES&S for technical support, please be near your equipment. In 
addition, be prepared to provide the following information to the support 
representative:

The version number of the product you are using.

The exact wording of any messages that appeared.

A description of what happened when the problem occurred.

Support representatives are available Monday through Friday between 8:00 A.M. 
and 5:00 P.M. central time. 

Refer to the System Acquisition Procedures heading in Chapter 1: Introduction for 
instructions for accessing the About window.

Contact an ES&S Support Representative
Telephone: 877-377-8683 (USA & Canada)

402-593-0101 (International)
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ES&S’s support services are subject to ES&S’s prices, terms and conditions in 
place at the time the service is used.

Install Audit Manager

Install Audit Manager before you run Election Data Manager or Image Manager. If 
your jurisdiction programs elections on more than one system, install Audit 
Manager to a network drive to maintain a shared audit log. After you install Audit 
Manager to the network, change your settings so that Audit Manager points to the 
same location for all of your user systems. 

1. Insert the installation CD into the CD-ROM drive.

2. Click Start on the Windows taskbar and select Run to open the Run window.

3. Click Browse to locate the CD ROM Drive on your PC. Find the Audit 
Manager (AMngr 7.5.0.0) folder and double-click it to open the folder.

4. Double-click on AuditManager.exe in the Audit Manager folder to place it on 
the open path: 

Fax: 402-593-8107

Write: Election Systems & Software

11208 John Galt Blvd.

Omaha, NE 68137 USA

NOTE: Make sure that proper hardware drivers are installed for your PC.

Contact an ES&S Support Representative
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 Chapter 1: Introduction 4
5. Click OK to begin the installation.

6. At the AuditManager InstallShield Wizard Welcome screen, click Next.
7. Click Yes to accept the License Agreement.

8. On the Customer Information screen, enter the User Name and Company 
Name and click Next.

9. At the Choose Destination Location screen, accept the default destination 
folder by clicking Next.

10. On the Select Program Folder screen, click Next to accept the default and 
begin installation.

11. Upon completion of the AuditManager installation, click Finish to complete the 
setup.

Contact ES&S technical support with any questions about installing Audit Manager to 
a network.

Election Security Caution: Install Audit Manager on a secure PC and network 
to enhance election security. Consult the information system personnel for your 
jurisdiction to make sure that network and PC security measures are the best 
possible for your system.

For information about updating an existing version of Audit Manager see 
Chapter 2: Start Audit Manager.
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General Timeline for Election Preparation

System Acquisition Procedures

Once you have installed Audit Manager, make sure your version matches the 
version listed on the purchase order. 

1. From the Help menu, click About. 

A window similar to the following will appear. 

90 Days Submit site support request to ES&S

63 Days All forms are due to ES&S (excluding Candidate 
forms)

56 Days Candidate forms due to ES&S

46 Days Last day to give ballot proofs to Counties (strictly for 
military or overseas voting).

45 Days Absentee Voting begins

42 Days Certification Deadline

28 Days All ballot proofs must be signed off

21 Days Last day to deliver Election Day ballots

20 Days Advance or early voting begins

18 Days Last day for ES&S to ship coding materials

10 Days Software Installation for pre-election procedures

1 Day Early voting ends

Refer to the Personnel Deployment and Training Requirements document for more 
information.
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 Chapter 1: Introduction 6
2. Verify that the version number at the top of the screen matches the version 
number on your purchase order. 

Back Up Data and Restore Backup Data

ES&S recommends that you back up all files in the \ELECDATA directory with 
your <election name> as well as the <election name> subfolder. Be sure to 
include all subfolders within the <election name> folder. If zipping the files, save 
the directory path. Back up data to a server.

Contact ES&S customer support if the Version number on your software does not 
match the purchase order.
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Chapter 2: Start Audit Manager

1. Click Start on the Windows desktop and select Programs.

2. Select Audit Manager from the program list to open the Audit Manager log in 
window.

3. ES&S supplies your initial user name and password when you purchase 
Election Data Manager. Enter your Password to access the Audit Manager 
main screen.

Manage the Users List

Assign all personnel with access to Election Data Manager a unique user name 
and password to make sure that unauthorized users do not gain access to 
Election Data Manager files. 

Election Security Caution: The Audit Manager user administration feature 
provides security for your election. Do not share user names or passwords, and 
change them frequently.
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 Chapter 2: Start Audit Manager 8
Enter User Information

Audit Manager keeps a history of every action taken within Election Data Manager 
and Ballot Image Manager. You can view audit log information as an overview of 
all action taken within the program or you can sort the audit data to view the 
actions of individual users.

Create a User Record

Create a record for each of your election workers with access to Unity software.

1. From the Edit menu, select Users to open the Users window:

2. Select New User to create a new user record.

3. In the User ID box, type an identification name for your new Unity software 
user. 

4. In the Password box, type an initial password for your new user.

5. In the Full Name box, type your user’s complete name.
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 Chapter 2: Start Audit Manager 9
6. Click Save to save your new user information or click Cancel to return to the 
Users list without saving the new entry.

Delete a User Record

Delete user records to cancel access to Unity software for election workers.

1. Under the Edit menu, select Users to open the Users window.

2. Click the single right arrow to advance the user list by one entry or the single 
left arrow to view the previous entry. Select the double left arrow to open the 
first user on the list or click the double right arrow to open the last user on the 
list. Locate and select the user record that you want to erase.

3. Click Delete User to remove the entry. A confirmation message appears.

4. Click Yes in the confirmation window to erase the user record.

Edit a User Record

Edit user records to change personal information or change access privileges for 
your election workers. 

1. Under the Edit menu, select Users to open the Users window.

2. Use the instructions under the Delete a User Record section of this chapter to 
locate a user record.

3. Select Edit User. 

Locate a User Record

Use the Find User option to search your user database.

1. Under the Edit menu, select Users to open the Users window.

2. Select Find User to open a search window.

Refer to the Create a User Record heading in this chapter for information about how 
to change user information.
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 Chapter 2: Start Audit Manager 10
3. Enter a user ID and click OK to search for a user. User information appears in 
the Users window or the message “Could not find the user,” appears.
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Chapter 3: Audit Log

The audit log saves all of the user actions carried out in Election Data Manager 
and Image Manager. View activity by all users or narrow your search to view the 
activities of specific users.

View the Audit Log

View your audit log to review all of the user actions performed by your election 
workers with Unity software.

1. Under the Audit menu, select View Log to open the View Log window:

2. Select the specific user whose actions you want to view from the Select User 
list. Select <all users> for a list of all actions carried out in Election Data 
Manager and Image Manager.

Election Security Caution: The audit manager log function provides security 
for your election. Print audit reports for every election and archive them 
physically and electronically with your other election materials.
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 Chapter 3: Audit Log 12
3. Enter dates and times in the To and From boxes to view portions of the audit 
log by date. Enter the dates manually or click the arrows next to the date 
boxes and select a date range from the calendar. 

4. Click Ascending under the Select Sort heading to view the oldest records at 
the top of the log and the most recent actions at the bottom. Select 
Descending to view the most recent actions at the top of the log and the 
oldest records at the bottom.

5. Click Get Data to display your requested audit data. 

In the Message column, numbers appear to the right in some of the rows. For an office title, the 
sequence number precedes the office title, followed by the number of candidates to vote for, 
followed by the term number. If a row contains a candidate, the party code appears to the right.

Print the Audit Log

In the View Log window, select Print to print your audit log.

NOTE: To view the Audit Log, ES&S recommends maximizing the View Log window. 
Click the Message column for a full screen view.

NOTE:  These numbers may not appear on some of the reports if the paper size, 
margins, or other formatting attributes do not allow the extra numbers to appear on 
the first page; the printer settings for the particular output device will need to be 
adjusted so that the entire audit log message can be displayed on a single page.

NOTE: Only the first 15 characters of the election name will appear on the audit log 
report. 
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 Chapter 3: Audit Log 13
The Audit Log shows activity for each user name, description of action performed, 
and the log name of users who are added, edited, and deleted. 

Export the Audit Data

Export your audit log to other locations or to a disk to save your audit records for 
review.

1. In the View Log window, select Export Data to send audit data to another file 
location.

2. Select the location where you want to save your audit data and click Save to 
send your audit file to a new location. Select Cancel to return to the Audit 
Manager main screen without saving the file.

Change the Audit Log View

Select options under the Windows menu to change the appearance of your Audit 
Log windows.

1. Under the Windows menu, select Cascade to place windows one on top of 
another.

2. Select Tile Horizontally to arrange your open audit log windows horizontally 
across the screen.

3. Select Tile Vertically to arrange your open audit log windows vertically across 
the screen.

4. Select a log from the Windows list under the Window menu to open the log in 
an active window.

Archive the Audit Log

Archive your audit log to free up log space for new user data.
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1. From the Audit menu, select Archive Log to open the Archive Database 
window:

2. In the From box, select a beginning date and then select an ending date in the 
To box to set the time frame for archiving records. Enter dates manually or 
click the arrows to select dates from the calendar.

3. Select Archive to archive the selected records and provide a name for the text 
file that will be created. Click Cancel to return to the main screen without 
archiving your records.

NOTE: Archiving selected records will permanently remove them from the Audit 
Manager interface and place them in the text file you create. Follow your jurisdiction’s 
standard procedures for securely archiving these records.
NOTICE OF UNCERTIFIED FUNCTIONALITY
The following products and/or system features HAVE NOT COMPLETED TESTING FOR CERTIFICATION BY THE ELECTION 

ASSISTANCE COMMISSION (EAC) to the requirements of the VSS:
Automated Bar Code Reader (ABCR)  iVotronic DRE Unity Data Acquisition Manager (DAM) 

Unity iVotronic Ballot Image Manager (iVIM)   Network results transmission and Networked central tabulators

AUDIT MANAGER SYSTEM OPERATIONS PROCEDURES v. 7.5.2.0
Confidential and proprietary to ES&S August 13, 2009



 Chapter 4: System Messages 15

CE COMMISSION (EAC) to the requirements of the VSS:
 Network results transmission and Networked central tabulators

YSTEM OPERATIONS PROCEDURES v. 7.5.2.0
August 13, 2009

Action

No further action is necessary.

No further action is necessary.

Contact ES&S.

Contact the system administrator and 
request account creation.

Try rebooting the PC. If this does not wrok, 
Contact ES&S.

Contact the system administrator to reset 
password.

Click Yes if you want to delete the account 
or No to cancel the action.

Contact ES&S.

Contact ES&S.

Contact ES&S.

Contact ES&S.
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AM System Messages
Error Messages Type of Message Explanation

Cannot delete ‘Admin’ user! Error Working as designed. The Admin account 
cannot be deleted.

Cannot delete ‘ESSdefault’ user! Error Working as designed. The default user cannot 
be deleted.

Could not add record Error

Could not find the user (username) Error User account does not exist.

Could not save changes. Error Changes could not be saved in Audit 
Manager.

Invalid Password, try again! Error Incorrect password entered.

Record will be deleted permanently. 
Proceed?

Warning Message warning user that the record will be 
permanently deleted.

Recordset doesn’t support the FIND 
method

Warning Cannot search for the RecordSet.

System Information Is Unavailable At 
This Time

Warning

Unable to open audit database. Error Audit Manager is unable to open the Audit 
Log.

Unknown IKeyValType Error
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Chapter 5: Revision History

Audit Manager v. 7.5.2.0 August 13, 2009
Chapter Description Project

Updated ‘Notice of Uncertified Functionality’ following 
the copyright page and disclaimer included in 
document footers.

Audit Manager v. 7.5.2.0 May 26, 2009
Chapter Description Project

Version Change

Audit Manager v. 7.5.0.0 April 3, 2009
Chapter Description Project

Network Results 
Transmission

Corrected spelling error (Nnetword to Network) under 
Network Data Transmission

Chapter 4: System 
Messages

Corrected spelling error (wrok to work) in the table 
under “Could not save changes.”
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 Chapter 5: Revision History 17
Audit Manager v. 7.5.0.0 October 17, 2008
Chapter Description Project

Chapter 1: 
Introduction

Added a new heading,  Operations Support 
Frequently Asked Questions providing information 
about the following. 
• how the system is purchased
• how the system is installed
• setup of the system
• how a user can verify the system
• the training needed

• the checklist to be followed

#27

Audit Manager v. 7.5.0.0 August 22, 2008
Chapter Description Project

Chapter 1: 
Introduction

Added the following note before the installation steps: 
“Make sure that proper hardware drivers are installed 
for your PC.”

(#284)

Chapter 3: Audit Log In the View the Audit Log section, under step 5, 
added a note stating what the numbers in the audit 
log represent. 

(#232)

Audit Manager v. 7.5.0.0 July 8, 2008
Chapter Description Project

Chapter 1: 
Introduction

Information about how to install Audit Manager has 
been added to Chapter 1: Introduction beginning on 
Page 3.

VVSG Vol 
2, Sec 
2.8.6 
(#436)
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 Chapter 5: Revision History 18
Audit Manager v. 7.5.0.0 May 19, 2008
Chapter Description Project

Chapter 1: 
Introduction

Removed installation instructions and added note 
referring to the new install instructions packaged with 
the CD on Page 3.

Chapter 1: 
Introduction

Added Backup Data and Restore Backup Data 
heading for procedures on safeguarding audit data

VVSG Vol. 
2, Section 
2.8.4.a,b

Chapter 3: Audit Log Added this new feature, Print the Audit Log with a 
screen print and text stating that the Audit Log shows 
activity for each user name, description of action 
performed, and the log name of users who are added, 
edited, and deleted.

ENH11977
&ENH1197
8

Chapter 3: Audit Log Added a note at the end of the View the Audit Log 
section describing how to maximize the window to 
read the Message column.

VVSG Vol. 
1, Section 
2.2.5.2.1.f 
(#291)

Chapter 4: System 
Messages

Replaced previous Error Messages with Chapter 4: 
System Messages, which explains the type of 
message, explanation of message, and action 
required.

VVSG Vol. 
1, Section 
2.1.5.1 b

Audit Manager v. 7.6.0.0 February 29, 2008
Chapter Description Project

Chapter 1: 
Introduction

Added step 10 to installation instructions, plus a 
pop-up window at the end of step 9.

51

Audit Manager v. 7.5.0.0 November 16, 2007
Chapter Description Project

Chapter 1: 
Introduction

Added Contact ES&S for Technical Support. Page 2 

Chapter 1: 
Introduction

Added Update or Reinstall Existing Version of Audit 
Manager. Page 7
NOTICE OF UNCERTIFIED FUNCTIONALITY
The following products and/or system features HAVE NOT COMPLETED TESTING FOR CERTIFICATION BY THE ELECTION 

ASSISTANCE COMMISSION (EAC) to the requirements of the VSS:
Automated Bar Code Reader (ABCR)  iVotronic DRE Unity Data Acquisition Manager (DAM) 
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 Chapter 5: Revision History 19
Audit Manager v. 7.5.0.0 July 13, 2007
Chapter Description Project

Chapter 1: 
Introduction

Added  System Requirements. Page 1 

Chapter 3: Audit Log Removed the Erase Audit Log Data section from the 
manual.

Chapter 3: Audit Log Made changes to item number 3 in the Archive the 
Audit Log section. Added note in the same section. 
Page 13

Chapter 4: Error 
Messages

Added Error Messages to manual.
NOTICE OF UNCERTIFIED FUNCTIONALITY
The following products and/or system features HAVE NOT COMPLETED TESTING FOR CERTIFICATION BY THE ELECTION 

ASSISTANCE COMMISSION (EAC) to the requirements of the VSS:
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